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FCC COMPLIANCE STATEMENT

FOR AMERICAN USERS

This equipment has been tested and found to comply with the limits for a class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
and television reception. However, there is no guarantee that interference will not occur 
in a particular installation. If this equipment does cause interference to radio and 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures:

❙ Reorient or relocate the receiving antenna

❙ Increase the separation between the equipment and receiver

❙ Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected

❙ Consult an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels that 
exceed the limits established by the FCC for this equipment. It is the responsibility of the 
user to obtain and use a shielded equipment interface cable with this device. If this 
equipment has more than one interface connector, do not leave cables connected to 
unused interfaces.

Changes or modifications not expressly approved by the manufacturer could void the 
user's authority to operate the equipment.

FOR CANADIAN USERS

This digital apparatus does not exceed the Class B limits for radio noise emissions from 
digital apparatus as set out in the radio interference regulations of the Canadian 
Department of Communications.

Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les limites 
applicables aux appareils numériques de Classe B prescrites dans le règlement sur le 
brouillage radioélectrique édicté par le Ministère des Communications du Canada.



IMPORTANT NOTICE
DISCLAIMER OF WARRANTY

Epson America makes no representations or warranties, either express or 
implied, by or with respect to anything in this manual, and shall not be liable 
for any implied warranties of merchantability and fitness for a particular 
purpose or for any indirect, special, or consequential damages. Some states 
do not allow the exclusion of incidental or consequential damages, so this 
exclusion may not apply to you.

COPYRIGHT NOTICE
All rights reserved. No part of this publication may be reproduced, stored in a 
retrieval system, or transmitted, in any form or by any means, electronic, 
mechanical, photocopying, recording, or otherwise, without the prior written 
permission of Epson America, Inc. No patent liability is assumed with 
respect to the use of information contained herein. Nor is any liability 
assumed for damages resulting from the use of the information contained 
herein. Further, this publication and features described herein are subject to 
change without notice.

TRADEMARKS
EPSON is a registered trademark of Seiko Epson Corporation.

PhotoPC and PhotoSpan are trademarks of Epson America, Inc.

EPSON Connection is a service mark of Epson America, Inc.

EasyPhoto and the EasyPhoto logo are trademarks of Storm Software, Inc.

General notice: Other product names used herein are for identification purposes only 
and may be trademarks of their respective owners. EPSON disclaims any and all rights 
in those marks.

Copyright © 1996 by Epson America, Inc. CPD3585
Torrance, California, USA 7/96

A NOTE CONCERNING RESPONSIBLE USE OF 
COPYRIGHTED MATERIALS

Like photocopiers, digital cameras can be misused by improper 
photographing of copyrighted material. Although Section 107 of the U.S. 
Copyright Act of 1976 (Title 17, United States Code), the “fair use” doctrine, 
permits limited copying in certain circumstances, those circumstances may 
not be as broad as some people assume. Unless you have the advice of a 
knowledgeable attorney, be responsible and respectful by not photographing 
published material without the permission of the copyright holder.
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   Introduction

Laguna Beach Community Newsletter/ Vol 8

Local Spotlight

Main Street Flower Shop

Just opened this month, Main Street 

Flower Shop is featuring fresh cut sun-

flowers at 40% off the regular price. 

Besides flowers, Main Street Flower 

Shop also sells arts and crafts made by 

local artisans. Free delivery will be 

available early next month.
Moon River Cafe

The local hotspot for southwestern cuisine has 

been re-opened after being closed for renovation 

since December of last year. Owner Julio Chavez 

believes the renovation will be a pleasant surprise 

to all the old faithful and welcoming to the new 

customers. The expansion will hopefully bring 

more people in to the restaurant for drinks and 

appetizers while entertaining those waiting to be 

seated in the dining room.

Be sure to call for reservations on the weekends.

Beach Regatta

Beginning Friday at 5:00pm the 27th 

Annual Laguna Beach Regatta will 

officially kick off. This year’s entries 

have increased to 220 competing 

attendees, up from 187 last year. Jim 

Smelt of Dana Point is back for a try at 

his fourth straight win. The race will 

start at 7:00am Saturday morning.

Restaurants   Page 2

Mayor Race  Page 3

Health Tips   Page 4

Events          
 Page 5

Sports         
   Page 6

Horoscope      Page 6

Inside This Issue

  Around   Town
our new EPSON® PhotoPC is a revolutionary, 

 easy-to-use digital camera that enables you to take full-color 

pictures and immediately use them on your Macintosh.® You may have 

thePhotoPC Mac version or the Mac Connectivity Kit and Photo PC 

Windows version. Either way, you have everything you need, including 

software that lets you transfer your pictures to your computer’s hard 

disk. You can edit, enhance, and organize your pictures or simply paste 

them into your documents.

Create professional letters, documents, and presentations with real life 

images right on your desktop. Share pictures with business colleagues or 

friends over the Internet. Add color and visual appeal to your 

newsletters, flyers, and brochures. Anything you can display on your 

screen or print will look better with PhotoPC pictures.

Y
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PhotoPC Features 
PhotoPC is a complete system for capturing digital images, and includes 

the following features: 

❙ Base unit with 1MB internal memory for 16 high-resolution images 

(640 × 480 pixels) or 32 standard-resolution images (320 × 240 

pixels)

❙ 24-bit color image capture

❙ Built-in flash with both automatic and manual settings

❙ Self-timer

❙ Automatic shut-off to save batteries

❙ Variable shutter speed

❙ Automatic date and time recording for each picture

❙ Cable for transferring photos to your Macintosh 

(or PC cable with Mac adapter)

❙ EasyPhoto software that lets you transfer, organize, enhance, and 

print your pictures

❙ Use your pictures with any application

❙ Print out your pictures on any color or black and white printer.

Optional Accessories

EPSON offers the following optional accessories for enhancing your 

PhotoPC: 

❙ 2MB and 4MB PhotoSpan memory modules 

❙ Universal AC adapter for use with a standard electric outlet.

You can also use standard 37 mm video camcorder lenses and filters 

available from leading suppliers, such as Tiffen.®

Minimum System Requirements 
❙ Macintosh with 68030 or higher processor or PowerPC

❙ System Software version 7.1 or later

❙ 8MB RAM (16MB recommended)

❙ At least 15MB free hard disk space

❙ VGA or SVGA monitor with at least 256-color display 

(thousands of colors recommended).
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Where to Get Help 
If you purchased your PhotoPC and/or Connectivity Kit in the United 

States or Canada, EPSON provides customer support and service 

through a network of Authorized EPSON Customer Care Centers. 

EPSON also provides the following services when you dial (800) 922-

8911:

❙ Technical assistance with the installation, configuration, and 

operation of EPSON products

❙ Assistance in locating your nearest Authorized EPSON Reseller or 

Customer Care Center 

❙ Customer relations

❙ EPSON technical information library fax service

❙ Product literature on current and new products.

You can purchase accessories, printed manuals, or parts for EPSON 

products from EPSON Accessories at (800) 873-7766 (U.S. sales only). 

In Canada, call (800) GO-EPSON. If you purchased your PhotoPC 

outside the United States or Canada, contact your EPSON dealer or the 

marketing location nearest you for customer support and service. 

If you need help with EasyPhoto software, contact Storm Software as 

described on page 4.

Electronic Support Services

If you have a modem, the fastest way to access helpful tips, 

specifications, drivers, application notes, and bulletins for EPSON 

products is through the online services described below.

World Wide Web

If you are connected to the Internet and have a Web browser, you can 

access EPSON’s World Wide Web site at http://www.epson.com. 

EPSON’s home page links users to What’s New, EPSON Products, 

EPSON Connection,SM Corporate Info, and EPSON Contacts. 

Link to the EPSON Connection for the latest drivers and FAQs 

(Frequently Asked Questions) and the EPSON Chat area. To get in touch 

with EPSON around the world, EPSON Contacts includes contact 

information for local EPSON subsidiaries. 

EPSON Internet FTP Site

If you have access to the Internet and an FTP client, you can download 

drivers, FAQs, and sample files from EPSON’s FTP site.  Use your FTP 

client or Web browser to log onto ftp.epson.com with the user name 

anonymous and your 

e-mail address as the password. 
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EPSON Download Service 

You can call the EPSON Download Service (BBS) at 

(800) 442-2007. No membership is required. Make sure your 

communications software is set to 8 data bits with 1 stop bit, no parity 

bit, and a modem speed up to 28.8 Kbps. See the documentation that 

came with your communications software for more information.

EPSON Fax-on-Demand Service

You can access EPSON’s technical information library by calling (800) 

922-8911 or (800) 442-2110 and providing a return fax number.

Epson Forum on Compuserve 

CompuServe members can call the Epson America Forum on 

CompuServe. If you are already a member, simply type GO EPSON at 

the menu prompt to reach the Forum.

If you are not currently a member of CompuServe, you are eligible for a 

free introductory membership as an owner of an EPSON product. This 

membership entitles you to:

❙ An introductory credit on CompuServe

❙ Your own user ID and password

❙ A complimentary subscription to CompuServe Magazine, 

CompuServe’s monthly publication.

To take advantage of this offer, call (800) 848-8199 in the United States 

and Canada and ask for representative #529. In other countries, call the 

following U.S. telephone number: (614) 529-1611, or your local 

CompuServe access number.

Where to Get Software Help

If you need help with your EasyPhoto software, you can contact Storm 

Software at the following numbers:

❙ Telephone: (415) 969-9555

❙ Fax: (415) 691-9825

If you have a modem and access to the Internet or other online service, 

you can also contact Storm Software at the following addresses:

❙ World Wide Web site:

http://www.stormsoft.com/storm/

❙ E-mail: support@stormsoft.com

❙ America Online: STORMSOFT

❙ CompuServe: 73060,3227

❙ Prodigy: UEJR16A



Introduction   5

A

B

Registration
Please take a minute to fill out the registration card included with 

PhotoPC and mail it back to us. This 

enables you to receive special information on software upgrades, 

accessories, and new products. You’ll get immediate attention if you 

have a problem with your PhotoPC.

Safety Instructions 
Read all of these instructions and save them for later reference. Also 

follow all warnings and instructions marked on the camera. 

❙ To reduce the risk of electric shock, do not remove the camera’s 

cover or open any compartments except as instructed in this User’s 

Guide.

❙ To prevent fire or electric shock, do not expose the camera to rain 

or moisture.

❙ Do not use outdoors during a thunderstorm.

❙ If the camera shows unusual signs such as noise, odor, or smoke, 

stop using it and turn it off immediately. Remove the batteries and/

or disconnect the AC adapter.

❙ Do not use harsh or abrasive cleaners. Wipe off dust with a clean, 

dry cloth.

❙ To avoid damage to the optics of the camera, do not expose the lens 

to direct sunlight for extended periods of time. 

❙ Do not store the camera near sources of bright light, direct sunlight, 

high humidity, heat, excessive dirt or dust, or where it is exposed to 

strong vibrations or magnetic fields.

❙ To prevent possible eye injury, do not take flash pictures of faces at 

close range.

❙ Avoid sudden temperature changes, which can cause moisture to 

condense on the camera. Keep the camera in a case or bag if you 

need to move it from a cold environment to a warm one. Allow 

time for the camera to adjust to temperature changes before

using it.
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hand strap batteries

camera

Mac adapter

software

PhotoPC cable 

his chapter helps you get ready to use your 

PhotoPC. It covers the following:

❙ Getting to know the camera

❙ Installing the batteries

❙ Attaching the hand strap

❙ Removing the plastic film

❙ Installing your EasyPhoto software

❙ Installing the PhotoPC Plug-in.

Unpacking Your PhotoPC
PhotoPC for the Macintosh is available in two packages: the Mac 

version, which includes all the parts shown to the left, and the Mac 

Connectivity Kit, which includes only the parts shown on page 1-2.

T
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The Mac Connectivity Kit works with the Windows Version of 

PhotoPC.  Make sure you use the software and cable that came in your 

Mac Connectivity Kit as shown below, and not the ones that came in the 

PhotoPC box.

.

Getting to Know the Camera
After you unpack your PhotoPC, take a few minutes to learn about its 

features, as shown to the right.

TITLE

                       Cam1-01.eps
DATE

                       6/26/95
DRAWN BY

                       L.Oliver

PhotoPC Mac cable

software

EPSON AMERICA, INC.
TITLE

                       Cam1-02.eps

viewfinderred timer light
flash

lens
battery cover

light sensor

power switch

port cover

EPSON AMERICA, INC.
Documentation Department
20770 Madrona Avenue, Torrance, CA 90503
(310) 782-0770

TITLE

                       Cam1-03.eps
DATE

                       6/26/95
DRAWN BY

                       L.Oliver

viewfinder

green standby light

shutter 
button

battery cover 
lock

control panel

hand strap holder
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Installing Batteries 
Your PhotoPC comes with four AA alkaline batteries. Make sure the 

camera is turned off, and follow these steps to insert the batteries: 

1 Slide the battery cover lock to the right to release the cover.

2 Grasp the battery cover and pull it away from the camera body as 

shown.

3 Insert all four batteries into the compartment, positioning the + and 

- ends as shown in the compartment. Arrange the ribbon under the 

batteries so you can use it to pull them out when you need to 

replace them. Press down on the batteries to snap them into place.

4 Replace the battery cover.

EPSON AMERICA, INC.
Documentation Department

TITLE

                       Cam1-04.eps
DATE

8/15/95

cam1-05

EPSON AMERICA, INC.
Documentation Department
20770 Madrona Avenue, Torrance, CA 90503
(310) 782 0770

TITLE

                       Cam1-05.eps
DATE

                       8/15/95
DRAWN BY
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Handling Batteries

When your PhotoPC batteries wear out, you can replace them with any 

of the following: 

❙ Single-use AA alkaline batteries

❙ Single-use AA lithium batteries (longest battery life)

❙ Rechargeable AA Ni-Cad batteries (shortest battery life).

WARNING

To avoid the danger of fire or explosion, do not mix different types of 

batteries. Do not allow the battery contacts to touch metal objects such 

as coins or keys, which could short out the battery’s circuits.

Note the following when handling batteries:

❙ Do not use manganese batteries.

❙ Replace all four batteries at the same time.

❙ Do not drop, puncture, disassemble, or mutilate batteries. Do not 

get them wet or expose them to fire.

❙ When the camera is not used for long periods of time, remove the 

batteries and store them at a low temperature in a dry location.

❙ Dispose of used batteries according to the battery manufacturer’s 

instructions and in compliance with all applicable laws. Contact 

your local government agency for information about battery 

recycling and disposal.

❙ If you use rechargeable Ni-Cad batteries, replace them with four 

fully-charged batteries. If you find that your batteries run out faster 

after you recharge them a number of times, make sure you 

discharge them completely before recharging.
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Attaching the Hand Strap 
To attach the hand strap, loop the strap around the holder on the side of 

the camera as shown below.

Removing the Plastic Film
To protect the camera from scratches, some parts have been covered 

with plastic film, as shown in the gray areas below. Peel off the plastic 

film before you use your camera.

Installing Your EasyPhoto Software 
PhotoPC comes with EasyPhoto, a software application that lets you 

transfer your pictures from the camera to your Macintosh and place them 

in documents. You can also use EasyPhoto to organize, enhance, and 

print your pictures.

TITLE

C 1 07

remove film

remove film
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If you have the PhotoPC Mac Version, use the software diskettes that 

came in the box with the camera. If you have the Mac Connectivity Kit, 

make sure you use the diskettes that came in the kit.

Follow these steps to install EasyPhoto:

1 Insert EasyPhoto diskette 1 in your diskette drive. 

2 Double-click the Install icon. You see the EasyPhoto setup screen.

3 Click Continue.

4 Click Install.

NOTE

If you want to have the time and date of each picture automatically 

recorded, see page 5-2 for instructions.

Installing the PhotoPC Plug-in
The software that you installed includes the PhotoPC 

Plug-in. This is the interface that lets you transfer pictures from the 

camera to your Macintosh. If you have other applications that support 

the Plug-in, such as Adobe® PhotoShop 3.0 or Adobe PhotoDeluxe, 

you can also use these applications to transfer pictures. 

First you need to install the Plug-in for PhotoShop or PhotoDeluxe. 

Follow these steps:

1 Open the EasyPhoto folder, then the EasyPhoto files folder, then 

the Plug-ins folder.

2 Click on the PhotoPC Plug-in.

3 Choose Make Alias from the File menu.

4 Drag the alias to the PhotoShop or PhotoDeluxe 

Plug-ins folder.

You can now use PhotoShop or PhotoDeluxe to transfer your pictures, as 

well as EasyPhoto. Turn to Chapter 2 for picture-taking instructions.
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2 sing PhotoPC to take pictures is similar to using

 a traditional “point and shoot” camera. This chapter shows you 

everything you need to know, including the following information: 

❙ Turning the camera on and off

❙ Saving power with auto shut-off

❙ Using the control panel 

❙ Checking the battery icon

❙ Snapping the shutter

❙ Taking pictures in range

❙ Adjusting settings

❙ Erasing pictures

❙ Checking the picture counter.

U
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PRICED AT $289,900

Lovely family home in a great neighborhood

3 bedrooms, 2 baths, master suite

Beautifully landscaped yard with pool and spa

Remodeled kitchen

Family room with fireplace

CALL KAREN BERGEN

555-4038. Ext. 125

1474 Hartford Ave., Tor rance, CA 90405

ANCHOR
REALTORS
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Turning the Camera On and Off 
To turn the camera on, simply slide the power switch to the ON position. 

The lens cover opens and the control panel on the top of the camera 

lights up. The green standby light on the back of the camera flashes for a 

few seconds. When it stops flashing and stays fully lit, the camera is 

ready to take pictures.

Slide the power switch to the OFF position to turn off the camera. The 

lens cover closes and the control panel turns off.

Saving Power with Auto Shut-off 
If you wait more than 60 seconds before taking a picture, the camera 

turns off automatically to save battery power. To turn the camera back 

on, slide the power switch OFF, and then ON. Or press the shutter 

button. You will have to press the shutter button again to take a picture.

If you want, you can change the 60-second time period for auto shut-off. 

For more information, see page 5-3.

Using the EasyTouch Control Panel
The control panel keeps track of how many pictures you’ve taken and 

gives you important information about the status of your battery and the 

settings you’re using.

power switch

control panelgreen standby
light

shutter button

AUTO

EPSON AMERICA, INC.
Documentation Department
20770 Madrona Avenue, Torrance, CA 90503
(310) 782-0770

TITLE

                       Cam2-03.eps
DATE

                       6/26/95
DRAWN BY

resolution mode

timer 

erase last picture
pictures taken

flash mode
battery level

pictures remaining
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Checking the Battery Icon
Before you take pictures, check the battery icon on the control panel. 

The icon shows how much battery power you have left, in the following 

four stages: 

Full battery power (or AC adapter in use) 

Battery power is decreasing 

Battery power is almost out 

Change batteries 

The battery icon is not precise, so you should use it only as a guide to 

remaining power. Several factors can affect battery life, including the 

surrounding temperature and the type of batteries you use. Low 

temperatures (especially below 50° F) weaken your batteries. See page 

1-3 for information about changing batteries. 

Snapping the Shutter
Follow these steps to take a picture: 

1 Turn the camera on and wait until the green standby light stops 

flashing.

2 Look straight through the viewfinder and center your subject.

3 Slowly press the shutter button.

4 Hold the camera still until the camera beeps and the standby light 

starts flashing.

The flashing light indicates that the camera has captured the image and 

is processing it. (If you try to press the shutter button again, you’ll hear 

an “error” beep.) When the light stops flashing, the image is saved. 

Saved images remain in memory for up to a year, even when the camera 

is turned off and the batteries are removed.

You can take another picture when the standby light stops flashing. If the 

light flashes longer each time you take a picture, your batteries are 

becoming weaker.

viewfinder

green standby light

shutter button
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NOTE

Remember that the camera shuts off automatically after 60 seconds. 

To turn the camera back on, slide the power switch OFF, and then 

ON. Or press the shutter button to turn on the camera. You will have 

to press the shutter button again to take a picture.

Taking Pictures in Range 
You should be at least 2 feet (60 cm) away from the subject you are 

photographing. If you want to take pictures at a closer range, you should 

use a 37 mm video camcorder close-up lens. See page A-5 for 

instructions.

However, if you use a close-up or “macro” lens, the viewfinder does not 

give you an accurate image of your picture. You may want to connect 

the camera to your Macintosh and view your close-up images on the 

screen before you capture them. See page 5-5 for information on 

viewing and taking pictures from your Macintosh.

You can take flash pictures within a range of 3 to 10 feet, as described on 

page 2-5.

TIP

When you’re taking pictures outdoors, make sure the sun is at your back. 

In very bright light (at the beach or in snow, for example), your pictures 

may come out too light. You can use an ND filter to reduce the amount of 

light. See page 6-5 for more information. 

Adjusting Settings
You can adjust the following three settings on PhotoPC using the 

EasyTouch control buttons on the top of 

the camera:

❙ Flash

❙ Resolution

❙ Timer.

Flash and resolution settings remain in effect even after you turn off the 

camera. 

NOTE

The controls return to their factory settings when you remove or change 

the batteries.
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Flash 

PhotoPC’s built-in flash has three settings as listed below, which are 

effective within a range of 3 to 10 feet. Press the flash control button to 

cycle from one setting to another. The settings appear on the control 

panel as shown to the right.

Auto 

The flash goes off automatically whenever it’s needed for 

adequate lighting (factory setting). 

Forced Flash

The flash goes off with every picture you take. Use this setting 

to compensate for backlighting; for example, when you are 

facing the sun. 

Flash Off

The flash is disabled, even when adequate lighting is not 

available. Use this setting for special effects, or where flash 

photography is prohibited. 

AUTO

EPSON AMERICA, INC.
Documentation Department
20770 Madrona Avenue, Torrance, CA 90503
(310) 782-0770

TITLE

                       Cam2-07.eps
DATE

                       6/26/95
DRAWN BY

                       L.Oliver

timer eraseresolution flash

AUTO
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Resolution 

PhotoPC has two resolution settings, high and standard. Press the 

resolution control button to switch from one setting to the other. The 

settings appear on the control panel as shown. 

.

High resolution 

Images are captured at 640 × 480 pixels. Your pictures include 

more detail, but the camera may hold only 16 pictures (factory 

setting).

Standard resolution 

Images are captured at 320 × 240 pixels. The camera holds at 

least 32 pictures, but the images include less detail.

You can switch freely between the two settings and store both standard 

and high resolution pictures in the camera. The camera’s capacity varies 

accordingly. For example, the camera holds 24 pictures if you take 8 at 

high resolution and 16 at standard resolution.

TIP

Choose high resolution if you want “snapshot”-size or larger pictures. 

Standard resolution is sufficient for “wallet”-size pictures.

The following examples show the same image captured at standard and 

high resolution.

resolution button

S
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High resolution image

640 × 480 pixels
Standard resolution image

320 × 240 pixels
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Timer 

Setting the timer creates a 10-second delay between the time 

you press the shutter button and the actual image capture. This 

allows you to take a picture of yourself. The timer icon on the 

control panel flashes when you use the timer.

Follow these steps to take a picture with the timer: 

1 Turn on the camera and wait until the green standby light stops 

flashing.

2 Secure the camera on a flat surface.

3 Press the timer button. The timer icon on the control panel flashes.

4 Press the shutter button. The red timer light on the front of the 

camera comes on and stays lit for 7 seconds. Then it flashes 3 

times. 

The camera beeps when the image is captured. The green standby 

light on the back of the camera flashes as PhotoPC processes the 

image. When the green light stops flashing, the timer is off and you 

can take another picture.

EPSON AMERICA, INC.
Documentation Department
20770 Madrona Avenue, Torrance, CA 90503
(310) 782-0770

TITLE

                       Cam2-14.eps
DATE

                       6/26/95
DRAWN BY

                       L.Oliver

timer button

red timer light

shutter button
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Erasing Pictures 
If you don’t want to keep the last picture you took, you can 

erase it from the camera’s memory. Using a small pointed 

object such as a ballpoint pen, press the erase button on the top 

of the camera. The erase icon on the control panel flashes when 

you press the button.

After a few seconds, the last picture you took is erased from the 

camera’s memory. The picture counter (number of pictures taken) 

decreases by one. You can continue pressing the button to erase more 

pictures.

TIP

You can also erase all the pictures in the camera’s memory. While 

holding down the erase button, press the timer button. The erase icon 

flashes until all pictures are deleted.

Checking the Picture Counter 
As shown below, the large number in the center of the control panel 

displays the number of pictures you have taken. The smaller number on 

the left shows how many additional pictures you can take.

The number of pictures remaining depends on your resolution settings. If 

you switch between standard and high resolution, the number of pictures 

remaining changes. For example, if the number of pictures remaining is 

2 at high resolution, it changes to 4 when you switch to standard 

resolution. 

erase
timer

AUTO

pictures takenpictures remaining
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NOTE

Depending on the type of images you capture, your camera may hold 

more than 16 pictures at high resolution or 32 at standard resolution. 

When you take the last picture, the number of pictures remaining may 

show one instead of zero. When this happens, you can take an extra 

picture—or several extra pictures. As long as the control panel shows 

one picture remaining, you can take another picture.

When the camera’s memory is full, the number of pictures remaining is 

0. The green standby light on the back of the camera goes off, and you 

can’t press the shutter button. You need to connect the camera to your 

computer and transfer the pictures. Then you can erase the images and 

start taking pictures again.

Turn to Chapter 3 to find out how to connect the camera to your 

Macintosh and transfer your pictures.
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hen you’re finished taking pictures, you can 

connect the camera to your Macintosh and transfer the images. 

Then you can use them in your letters, presentations, or just about 

anything you create on your Macintosh. This chapter tells you how, 

including:

❙ Connecting PhotoPC to your Macintosh

❙ Transferring pictures to your Macintosh

❙ Erasing pictures from the camera

❙ Using pictures in your documents

❙ Closing EasyPhoto.

3   Using PhotoPC with Your Macintosh

W Connecting PhotoPC to Your Macintosh
If you have the PhotoPC Mac Version, you’ll use the cable with the Mac 

adapter to connect the camera to your Macintosh. If you have the Mac 

Connectivity Kit, you’ll use the cable that came in the kit.

If you have the optional AC adapter, you can save on batteries by using 

the adapter whenever you connect the camera to your Macintosh.

The universal AC adapter should be available where you bought your 

PhotoPC. If not, you can order an AC adapter by calling EPSON 

Accessories at (800) 873-7766 (U.S. sales only). In Canada, call 

(800) GO-EPSON.

Follow these steps to connect the camera:

1 Make sure the camera is finished processing (the green standby 

light is not flashing). Turn off the camera and shut down and turn 

off your Macintosh.
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2 Locate the port cover on the side of the camera. Press on the arrows 

and slide the cover down to open it.

3 If you’re using the cable in the Mac Connectivity Kit, line up the 

arrow on the white end of the cable with the notch on the camera’s 

serial port. Then insert the connector. Continue with step 5.

If you’re using the PhotoPC Mac version, you’ll have a short Mac 

adapter cable in addition to the long PhotoPC cable. Connect the 

smaller end of the long cable to the camera’s serial port as shown.

4 If you’re using the PhotoPC cable that came with the camera, 

connect it to the Mac adapter cable as shown, and tighten the 

connector screws.

arrows

EPSON AMERICA, INC.
TITLE

                       Cam3-02.eps
DATE

serial port

notch

arrow

PhotoPC cableMac adapter
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5 Locate the modem port or printer port on the back of your 

Macintosh, marked with these icons:

6 With the arrow on the cable facing up, line up the cable connector 

with the port on your Macintosh. Then insert the connector. 

7 Turn on the camera and your Macintosh. A frame appears around 

the picture counter on the camera’s control panel.

NOTE

When the camera is connected to your Macintosh, you can’t use any of 

the control buttons or the shutter button on the camera. You can  operate 

the camera only through your Macintosh.

The camera’s auto shut-off feature remains in effect when the camera is 

connected to your Macintosh, but shut-off takes place after 5 minutes of 

inactivity instead of 60 seconds. To turn the camera back on, you can 

slide the power switch off and on again, or you can use any of the 

software camera controls on your Macintosh, as explained in Chapter 5.

PhotoPC Mac cable or 
Mac adapter cableprinter port on 

Macintosh

modem port on 
Macintosh

AUTO

TITLE

Line indicates that the camera is 
connected to your Macintosh.
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Transferring Pictures to Your Macintosh
Once your camera and Macintosh are connected and turned on, you’re 

ready to transfer your pictures. You can use the EasyPhoto software that 

came with your PhotoPC Mac Version or in the Macintosh Connectivity 

Kit. If you haven’t installed the software yet, do it now, following the 

instructions on 1-5. 

Before you start, open the Chooser and make sure AppleTalk is inactive.

NOTE

If you have questions or need help as you work with your software, you 

can use the EasyPhoto Guide or Tips on the Help menu.

Follow these steps to transfer the pictures to your Macintosh:

1 Double-click the EasyPhoto icon. The first time you use 

EasyPhoto, you see the Add Photos window and a new gallery, 

“Untitled 1.” (If you have used EasyPhoto before, click the Add 

Photos to Gallery button to see the Add Photos window.)

:
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2 Click the PhotoPC button and click OK. Your pictures appear one-

by-one in the PhotoPC window.

If you see an error message, make sure AppleTalk is inactive, and 

your port settings are correct. See page 6-3 for more information.

3 To transfer all pictures to your Macintosh, click Add All to Gallery. 

To select pictures individually, click each picture you want to 

transfer, and then click Add to Gallery. If you select a single 

picture, EasyPhoto prompts you to name it. You don’t have to wait 

for all the pictures to appear before you start selecting pictures to 

transfer.

EasyPhoto displays its progress as it transfers and stores each 

picture. Small “thumbnail” versions of the images are added to the 

new gallery. EasyPhoto labels your pictures with the current date 

and numbers them in order. After the transfer is finished, you can 

double-click on a picture in the gallery to view it at full size.

NOTE

If the transfer process seems too slow, try increasing your port 

speed. See pages 5-4 to 5-5 for more information.

4 Turn off the camera. The transfer process uses a lot of power, and 

your batteries can run out quickly.

NOTE

Once you install EasyPhoto and the PhotoPC Plug-in, you can use any 

program that supports the Plug-in (such as Adobe Photoshop 3.0 or 

Click below a picture to display the date and time when the picture was 
taken. These are accurate only if you connected the camera to your 
Macintosh and set the clock before taking the picture. (See page 5-2  for 
instructions.)
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Adobe Photo Deluxe) to transfer your pictures. Select PhotoPC as the 

source when you acquire an image. You will see the PhotoPC window. 

You may need to transfer your pictures individually or in small groups, 

rather than all at once.

Erasing Pictures from Your Camera 
After you have viewed your pictures and transferred them to your 

Macintosh, you can erase them from your camera. Make sure the camera 

is turned on and connected to your Macintosh before you start. Then 

follow these steps:

1 In the gallery, click Add Photos to Gallery. The Add Photos 

window appears.

2 Click PhotoPC and click OK. The PhotoPC window appears.

3 From the PhotoPC window, click Erase All. EasyPhoto asks you to 

confirm that you want to erase all the pictures in the camera.

4 Click Erase All. Your pictures disappear from the screen, and the 

camera resets its counter to 0.

NOTE

You can also use the Erase button in the Camera Controls window 

(shown on page 5-7) to erase pictures. After you disconnect the camera 

from your computer, you can use the erase button on the camera. See 

2-9 for instructions.

If you want to close EasyPhoto now, see page 3-11. To use a picture in a 

document, go to the next section.

Using Pictures in Your Documents
When your pictures are saved in a gallery, you can place them in your 

documents. You can use your pictures in many different types of 

software applications, such as word processors, presentation programs, 

spreadsheets, database managers, page layout, and desktop publishing 

packages.

If you want to change a picture before you insert it, you can open it in an 

EasyPhoto Workshop window and crop, resize, rotate, or make other 

kinds of enhancements. 

For more information about the EasyPhoto Workshop, see Chapter 4 or 

use the EasyPhoto Guide or Tips. 
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You can use three methods to add pictures to your documents: 

❙ Copy and paste

❙ Drag and drop

❙ Importing.

Inserting a Picture with Copy and Paste 

You can use this method to insert a picture in any Macintosh application.

NOTE

If your Macintosh has less than 16MB RAM, you may need to increase 

your virtual memory setting  and the memory allocation for your 

application. See pages 6-3 to 6-4 for more information.

Follow these steps to copy and paste a picture:

1 Make sure the picture you want to use is showing in the gallery on 

your screen.

2 Click on the picture to select it and choose Copy from the Edit 

menu, as shown below.

Alternatively, you can double-click on the picture to open it in a 

Workshop window. You may find that your pictures look better 

when you copy them from the Workshop. When using a Workshop 

window, you have to choose Select All from the Edit menu before 

you choose Copy.

3 Start your word processor or other application.

4 Open the document where you want to use the picture.

Copying a picture from an 
EasyPhoto gallery
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5 Position the insertion point where you want to add the picture.

6 Choose Paste (or Paste Special) from the Edit menu:

A copy of the picture appears in your document:

Pasting a picture into a word-processing document
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Inserting a Picture with Drag and Drop 

You can use this method with any application that supports it—for 

example, Microsoft® Word 6.0 or PageMaker® 6.0. If you’re not sure, 

give it a try. If it doesn’t work, you can use the copy and paste or 

importing method.

Follow these steps to drag and drop a picture into your document:

1 Make sure the picture you want to use is showing in the gallery on 

your screen. 

2 Start your application.

3 Open the document where you want to use the picture. Make sure 

your screen displays both the document and gallery windows, as 

shown to the right.

4 Drag the picture from the gallery to your document. You see an 

outline of the picture showing its size on the page.

5 Position the outline where you want the picture and release the 

mouse button. In a few seconds, a copy of the picture appears in 

your document.

EasyPhotog
allery Document in word processor
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Inserting a Picture by Importing

If your application can’t import a JPEG file, you need to change the 

picture’s file type to PICT. See 4-10 for instructions. Then follow these 

steps:

NOTE

If your Macintosh has less than 16MB RAM, you may need to increase 

your virtual memory setting and the memory allocation for your 

application. See pages 6-3 to 6-4 for more information.

1 Start your application.

2 Open the document where you want to use the picture.

3 Position the insertion point where you want to place the picture.

4 Choose the Insert Picture command. The command may have a 

different name in your application. It may appear on the File menu, 

the Insert menu, or another menu. 
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After you choose the command, you see a document selection 

dialog box like the following:

5 Locate and select your picture.

6 Click the Insert button. The picture appears in your document. 

Closing EasyPhoto 
When you are finished working with your pictures, follow these steps to 

close EasyPhoto: 

1 Choose Quit from the File menu. EasyPhoto asks if you want to 

save the new gallery document.

2 Click Save. EasyPhoto then prompts you to name the gallery.

3 Type a name and click Save. The gallery is saved, and you can use 

it to access your pictures whenever you want.

NOTE

The EasyPhoto Guide tells you how to use EasyPhoto with pictures 

from other sources, such as scanners and photo CDs. You can use 

EasyPhoto to work with picture files in the following formats: 

❙      JPEG (read/write) ❙       Photo CD (read)

❙      PICT (read/write) ❙      GIF (read)

❙      BMP (read) ❙       PhotoShop 2.5 (read)

❙      TIFF (read) ❙      EPS (read)
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4   Working with Your Pictures

 sing your EasyPhoto software, you can organize 

 your pictures in galleries, enhance the images with the Workshop, 

and add visual impact to almost any kind of document with your photos. 

To find out how to transfer pictures to your Macintosh and insert them in 

your documents, see Chapter 3. You can also use the EasyPhoto Guide 

or Tips to get software instructions.

This chapter describes the following EasyPhoto activities:

❙ Using galleries 

❙ Making changes with the Workshop 

❙ Saving and printing your pictures

❙ Changing picture file information.

UProposal: City of Torrance

MLS+Associates have been working

with City Urban Planning Commis-

sions for the last 45 years. The availabil-

ity of a senior architect throughout a

project is one of the main reasons we

MLS+ Associates Architects

have been awarded more than 75% of the
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Using Galleries
When you transfer your pictures from the PhotoPC camera to your 

Macintosh, they are stored in a gallery, shown on the right. Using the 

slide show feature, you can turn a gallery into a slick presentation on 

your screen.

You can easily rearrange the pictures in a gallery by clicking and 

dragging. You can also open several galleries at once and drag 

thumbnails from one to the other. This lets you organize your pictures by 

subject matter, project, or in any way you want.

Adding or Changing Picture Information 

In addition to displaying small thumbnail versions of your pictures and 

short titles, galleries store more detailed information about each image. 

You can pause the mouse pointer on the picture’s title to display the 

following information on a title card:

❙ Caption 

❙ File name and location

❙ File size and media (hard disk drive, floppy disk, or CD).

Press Option and point to the title to display the following additional 

information about your picture:

❙ Number of colors

❙ Dimensions

❙ Resolution.

Click to edit title and caption

Click here for a tip

Caption:Colorful shops at Venice Beach, California

File:COURTYRD.JPG
Size: 87K

Media: Floppy Disk
Colors: Milllions

Dimensions: 640 pixels wide, 480 pixels high
Resolution: 144 dpi

Point here to display information

Gallery showing technical information card
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Follow these steps to add a caption or change a picture’s title:

1 Click the photo to select it.

2 Click the Edit Photo Information button on the toolbar. The Photo 

Info window appears, as shown:

3 Type the text you want for the picture’s title or caption. 

The same picture may have a different title and caption in another 

gallery.

4 Close the Photo Info window when you’re finished.

Finding a Picture

It’s easy to find a picture in one of your galleries. You can search for a 

picture using a word or phrase in its title or caption. You can even find a 

picture that resembles another picture.

Follow these steps to search for pictures by words:

1 Choose Find Photos by Words from the Gallery menu. The 

following dialog box appears:

2 Type the word or phrase you’re looking for.

3 Under Where To Look, click In the Current Gallery or In All 

Galleries.

4 Click OK. EasyPhoto displays a new gallery that contains all 

pictures with your word or phrase in their title or caption.

Type title here

Type caption here

Type search 
text here
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Follow these steps to search for pictures by example:

1 Open the gallery that has the picture you want to use as an example.

2 Choose Find Photos by Example from the Gallery menu. A dialog 

box like the following appears:

3 Use the scroll bars to display the example photo.

4 Under Where To Look, click In the Current Gallery or In All 

Galleries. 

5 Click OK. EasyPhoto displays a new gallery with all pictures that 

resemble the example picture.

Displaying a Gallery as a Slide Show

The Slide Show feature lets you present a series of pictures at full size 

against a dramatic black background. You can play the show 

automatically or interactively with the Slide Show Controls.

1 Choose Display As Slide Show from the Gallery menu.

The gallery’s first picture appears full-size on the screen, with the 

Slide Show Controls box in the lower-right corner:

2 Press Esc to quit the slide show and return to your desktop.

Use the EasyPhoto Guide if you need more information or if you want to 

customize the slide show.

Drag until you see the 
picture you want to use 
as an example

Show next slide and 
pause

Play

Show previous 
slide and pause

Pause

Stop

Repeat/ Play once 
toggle

Click to hide 
captions
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Making Changes with the Workshop
EasyPhoto’s Workshop lets you make the following kinds of changes to 

your pictures: 

❙ Cropping

❙ Resizing

❙ Rotating

❙ Adjusting brightness and contrast

❙ Adjusting colors

❙ Removing red-eye

❙ Cutting, copying, pasting, and flipping.

To open a picture in a Workshop window, double-click 

its thumbnail in the gallery. Your picture appears in a Workshop window 

like the one on the right.

If you need a closer look at your picture, you can use the zoom feature. 

Click the Zoom In button, and then click on your picture. Click the 

Zoom Out button, and then click on your picture again to return to your 

original view. NOTE

You can also use image editing software such as Adobe Photoshop to 

enhance or modify your pictures.

Select 
Rectangle

Crop

Resize Rotate

Adjust Brightness and 
Contrast

Adjust Colors

Move

Zoom 
Out

Remove red-eye

 Select 
Freehand

Zoom 
In
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Cropping 

You can crop your pictures by selecting either a rectangular area or a 

freehand area to keep; everything outside of the area is cut away. Follow 

these steps:

1 Click either the Select Rectangle button or the Select Freehand 

button.

2 Drag the mouse to enclose the area you want to keep. A dotted line 

appears around the selected area.

3 Click the Crop button. EasyPhoto deletes everything outside of the 

selected area.

Resizing

When you change the size of your picture, EasyPhoto automatically 

keeps the original proportions and resolution. Your picture retains its 

high quality and is never distorted. Follow these steps:

1 Click the Resize button. Arrows appear in the corners of your 

picture and your pointer becomes a resize tool.

2 Drag the resize tool to change your picture’s size. Length and width 

information is displayed in the lower left corner of the window as 

you work.

3 Release the mouse button when the picture is the size you want.

4 Click another button or press Esc when you’re finished.

NOTE

You can also use your word processor or other software to change the 

size of a picture after you import it.

Rotating

You can rotate your picture and tilt it at any angle you want. Follow 

these steps:

1 Click the Rotate button. Curved arrows appear around your picture 

and your pointer becomes a rotate tool. 

2 Drag the rotate tool to turn your picture. Rotation information is 

displayed in the lower left corner of the window as you work.

3 Release the mouse button when the picture is rotated the way you 

want it.

4 Click another button or press Esc when you’re finished.
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Adjusting Brightness and Contrast

Changing the brightness of a picture lets you make it lighter or darker; 

changing the contrast adjusts the difference between the picture’s light 

and dark areas. Follow these steps:

1 Click the Brightness and Contrast button. You see a window like 

the one to the right:

.

2 Drag the sliders to make the adjustments you want. The After 

sample shows you the results of your changes.

3 When you’re done, click OK to keep your changes and close the 

Brightness/Contrast window. 

Adjusting Colors

You can change the way your picture looks by adjusting the intensity 

and relationship of the three primary colors on your screen: red, green, 

and blue. Follow these steps:

1 Click the Adjust Color button. You see a window like the one 

below:

Drag to 
adjust 
brightness 

Drag to 
adjust 
contrast

Drag to see a 
different part 
of the picture 
in the windows

Drag to see a 
different part of 
your picture in 
the windows

Drag to adjust 
colors
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2 Drag the sliders to change the red, green, and blue colors in your 

picture. The After sample shows you the results of your changes.

3 Click OK to save your changes to the picture.

NOTE

If you want to change the colors, brightness, or contrast in only one part 

of your picture, select that part before you make the adjustment.

Removing Red-Eye

When you take flash pictures of faces, sometimes people’s eyes appear 

red. Follow these steps to fix the red-eye problem:

1 Click the Select Freehand button. 

2 Drag the mouse to select the eye area.
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3 Click the Remove Red-Eye button. You see a window like the one 

below:

4 Drag the slider until the eyes look normal in the After sample.

5 Click OK to save your changes to the picture.   

Cutting, Copying, Pasting, and Flipping

You can choose Cut, Copy, or Paste from the Edit menu to take a 

selected part of one picture and add it to another picture. You can also 

“reverse” your picture or turn it into a mirror image. 

❙ Choose Cut from the Edit menu to remove a selected area. A white 

“hole” appears where you made the cut. EasyPhoto places the cut-

out area on the Clipboard.

❙ Choose Copy from the Edit menu to place a copy of the selected 

area (or the entire picture if there is no selection) on the Clipboard. 

The original picture is not affected.

❙ Choose Paste from the Edit menu to paste an image from the 

Clipboard into another picture. 

❙ From the Edit menu, choose Flip Horizontal to flip your picture 

from left to right or Flip Vertical to flip it from top to bottom.

Saving and Printing Your Pictures
When you’re finished working with your picture in the Photo Workshop, 

you should save it. Then you can place it in one of your documents or 

just print it out. 

❙ Choose Save from the File menu to save your picture. 

❙ Choose Print from the File menu to print your picture. You can also 

use a gallery’s menu to print out all the thumbnails.

Drag to fix 
red-eye
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Changing Picture File Information
When you work with EasyPhoto, you don’t need to keep track of your 

picture files. EasyPhoto does it for you. However, you can change a 

picture’s file name, file type, or move it to a new folder if you want. 

Follow these steps:

1 In a Workshop window, choose Save Photo As from the File menu. 

A dialog box like the one to the right appears.

EasyPhoto names your picture files according to the date and order 

in which they were transferred from the camera. The original file 

type is JPEG, which provides high image quality in small, 

compressed files.

2 Choose a new folder or disk, if you want.

3 Choose the file type: either JPEG or PICT. PICT files are larger (in 

bytes) than JPEG files, but you can insert or import them into most 

Macintosh software applications.

4 Type a name for the file in the Save Photo As box. 

5 Click Save. EasyPhoto saves a copy of your picture with the new 

information.

EasyPhoto puts a thumbnail for the new picture in the current gallery. 

You have two copies of the picture: one with the new file information 

and one with the original file information. You can delete the original if 

you don’t need it. 

NOTE

See the EasyPhoto Guide in the Help menu if you want to change the 

folder where your pictures are automatically saved.

EasyPhoto 
automaticallysa
ves your 
pictures in this 
folder

Type the file 
name here



Using Advanced Features   5-1

B

5

hen PhotoPC is connected to your Macintosh, you 

can customize several of the camera’s settings. You can also 

take pictures by controlling the camera directly from your 

Macintosh. This chapter describes the following:

❙ Getting ready to use advanced features 

❙ Setting the clock

❙ Setting auto shut-off

❙ Setting the shutter speed

❙ Adjusting port settings

❙ Taking pictures from your Macintosh.

Getting Ready to Use Advanced Features 
You use the PhotoPC Settings software to work with advanced features. 

Follow these steps to get started: 

1 Connect the camera to your Macintosh as described in Chapter 3.

5   Using Advanced Features 

W 2 Turn on both the camera and your Macintosh system.

3 Double-click the PhotoPC Settings icon, shown below, in the 

PhotoPC software folder. 

The Camera Controls window appears, as shown on page 5-2.
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You can switch between Setup and Controls by clicking on the buttons.

NOTE

You can also access the Camera Controls windows from the 

PhotoPC screen. Click the Camera Options button.

Setting the Clock 
If you set the clock, PhotoPC automatically records the correct date and 

time of your pictures. When you transfer the pictures from the camera to 

your Macintosh, you can see exactly when each shot was taken. 

In order to have the time and date recorded, you need to set the camera’s 

clock from your Macintosh. 

NOTE

After you set it, the PhotoPC clock keeps time accurately until you 

replace the batteries; at that point you need to connect the camera to 

your Macintosh and reset the clock. 

Follow these steps to set the camera’s clock:

1 Connect the camera to your Macintosh and open the Camera 

Controls window as described on page 5-1.

The Date/Time box shows the current values in your camera’s 

internal clock. Use the arrow buttons to change these values if 

necessary.

2 Click OK. EasyPhoto updates the date and time in your camera.

Drag to customize auto shut-off

Click to change date and time, if necessary



Using Advanced Features   5-3

A

5

Setting Auto Shut-off 
PhotoPC’s power-saving feature automatically shuts off the camera if 

you wait more than 60 seconds before taking a picture.

You can adjust this time period by connecting the camera to your 

Macintosh and using PhotoPC Settings. Follow these steps: 

1 Connect the camera to your Macintosh as described in Chapter 3 

and open the Setup window as described on page 5-1.

The Auto Shut-off slider is set to 1 minute, as shown on page 5-2.

2 Drag the slider to the left to reduce the time period, or to the right to 

increase it. 

As you move the slider, the screen shows the number of minutes. 

You can select from 0 to 5 minutes.

If you select 0, the camera shuts off immediately after your picture 

is captured and saved to memory. When you turn it back on, you 

have just 30 seconds to take a picture after the standby light stops 

flashing.

3 When you are finished, click OK. 

NOTE

Auto Shut-off occurs after 5 minutes when the camera is connected to 

your Macintosh. You can’t change this time period.

Setting the Shutter Speed 
When the camera is connected to your Macintosh, you can use PhotoPC 

Settings to adjust the shutter speed. Slower shutter speeds allow more 

light to strike the lens; faster speeds allow you to take “stop-action” 

pictures of moving subjects. Shutter speed settings remain in effect only 

while the camera is connected to your Macintosh.

The factory shutter speed is Auto, which means that PhotoPC 

automatically adjusts the shutter speed based on the amount of light 

available. You will probably want to use this setting most of the time, 

unless you are planning to take stop-action pictures or use special 

lighting effects.

NOTE

When you adjust the shutter speed manually, you can’t use the 

auto flash setting. To take a picture with the flash, you need to use the 

forced flash setting. See page 2-5 for more information.
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To set the shutter speed, follow these steps:

1 Connect the camera to your Macintosh as described in Chapter 3 

and open the Setup window as described on page 5-1.

The Shutter Speed slider is set to Auto.

2 Drag the slider to the left to reduce the shutter speed, or to the right 

to increase the shutter speed. The shutter speed range is from 1/30 

second to 1/10,000 second. 

3 When you are finished, click OK.

Adjusting Port Settings 
You can use PhotoPC Settings to adjust the computer connection for 

PhotoPC. You need to adjust these settings if you see an error message 

when you connect the camera. You may also want to experiment with 

the speed setting to decrease the time it takes to transfer pictures to your 

Macintosh. 

Click to change port for camera 
connection

Click to change speed for 
transferring pictures

Drag to set shutter speed
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Change the Port setting only if you want to use a different port for the 

camera or you get an error message. When you change the Port setting, 

you lose the connection between the camera and your Macintosh.

Follow these steps to set the port and speed for your PhotoPC 

connection: 

1 Connect the camera to your Macintosh as described in Chapter 3 

and open the Setup window as described on page 5-1. The 

Computer Connection box shows the current port settings.

2 Click the arrow to change the Port setting. You can select the 

modem port or the printer port. 

3 Click the arrow to change the Speed setting. 

4 When you are finished, click OK.

NOTE

EasyPhoto automatically chooses a speed that works with most 

Macintosh computers. You can experiment to choose the fastest speed 

that works on your system. The following settings are avaliable:

❙     9600

❙     19,200

❙     38,400

❙     57,600

 Increasing the port speed allows you to transfer pictures from the 

camera to your Macintosh much faster. Your batteries will last longer 

too.

Taking Pictures from Your Macintosh 
When the camera is connected to your Macintosh, you can take pictures 

and use PhotoPC features through the software on your Macintosh. The 

only control you can use on the camera itself is the power switch. 

When you take pictures from your Macintosh, you can see each image 

on your screen before you capture it. This “live preview” feature works 

somewhat like a video camera, except that the image moves more 

slowly. Live preview is especially helpful when you are using a close-up 

lens. 
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NOTE 

Taking pictures from your Macintosh with live preview uses a lot of 

battery power. If you don’t have the PhotoPC AC adapter, you may want 

to buy it. See Appendix A for more information about obtaining and 

using the AC adapter.

The Auto Shut-off feature remains in effect when the camera is 

connected to your Macintosh (except when you use live preview). 

However, the camera is shut off after 5 minutes of inactivity. To turn the 

camera back on, slide the power switch off and on again.

Follow these steps to take pictures from your Macintosh:

1 Connect the camera to your Macintosh as described in Chapter 3.

2 Position the camera so that it faces the subject. Using a tripod gives 

you maximum flexibility in setting up your shots.

3 Turn on both the camera and your Macintosh system.

4 Double-click the EasyPhoto icon. A gallery appears.

5 Click the Add Photos to Gallery button. The PhotoPC screen 

appears.

6 Click the Camera Options button. The Camera Controls window 

appears, as shown on page 5-7.

7 Click Show Live Preview to display your image in the viewfinder 

window.

You can move or tilt the camera until you see the image you want 

to capture in the window. The image is updated every three 

seconds.
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You can click the buttons on your screen to set the resolution, flash, 

timer, and erase features, just as you use the buttons on the camera. The 

control panel on your screen displays the same information as the 

control panel on the camera. For more information about the control 

panel, see Chapter 2.

Snapping the Shutter 

To snap the shutter from your Macintosh, simply click the Take Picture 

button. The green standby light flashes and the camera beeps. When the 

standby light stops flashing, the image is saved and you can shoot 

another picture.

NOTE

You can’t turn off the camera when you’re using live preview. Click 

Show Live Preview to turn off the live preview feature, and then turn off 

the camera.

set resolution erase

set timer set flash

viewfinder window

control panel
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our PhotoPC is easy to take care of, and any 

problems you may have are easy to solve. This chapter covers 

the following:

❙ Caring for the camera

❙ Solving camera problems

❙ Solving picture problems.

If you can’t solve a problem after checking the solutions in this 

chapter, see page 3 of the Introduction for information on where to 

get help.

Caring for the Camera 
Your PhotoPC camera requires only the most basic care. Before you 

do any maintenance procedures on the camera, be sure to read the 

Safety Instructions in the Introduction. 

6   Maintenance and Troubleshooting

Y Then follow these guidelines:

❙ Use a clean, dry cloth to keep the camera free of dust. 

❙ Don’t use harsh or abrasive cleaners.

❙ To clean the lens, first blow off any loose dust or dirt. Then breathe 

on the lens and wipe off all moisture with a soft, lint-free cloth or 

lens cleaning tissue. 

❙ To avoid scratching the lens, don’t press too hard.

❙ Keep the lens covered (power switched off) when you’re not using 

the camera.

❙ If necessary, clean the battery contacts with a dry cloth.
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Don’t store the camera in the following locations: 

❙ Where it is exposed to direct sunlight, for example, on a car 

dashboard

❙ Near sources of bright light or high humidity

❙ Near heat sources or in a closed car

❙ In areas with excessive dirt or dust

❙ Where it is exposed to strong vibrations or magnetic fields.

Solving Camera and System Problems
Before you call for help, check this list of problems and possible 

solutions. 

The camera has no power. 

❙ Check the power switch and make sure the camera is turned on.

❙ The camera may have shut off automatically. Slide the power 

switch off and then on.

❙ Check the batteries and make sure they are installed correctly. 

Replace the batteries if necessary, following the instructions on 3.

❙ If you are using the AC adapter, make sure it is plugged into a 

working outlet.

You can’t take a picture with the camera.

❙ The camera may have shut off automatically. When you press the 

shutter button, the camera turns on. You have to press the button 

again to take a picture.

❙ The flash may be recharging. Wait until you see the green standby 

light, and try again.

❙ The camera may be full. Check the picture counter on the control 

panel. Erase a picture using the erase button, or transfer the pictures 

to your Macintosh and then erase them. See Chapter 3 for 

information about transferring your pictures and erasing them with 

your Macintosh.

❙ The camera may be connected to your Macintosh. When it’s 

connected, you can’t use any of the controls on the camera itself. 

See 5 for instructions on taking pictures from your Macintosh.

The flash doesn’t work.

❙ Make sure the flash setting is either automatic or forced flash as 

described on page 5.

❙ Check the batteries and make sure they are installed correctly. 

Replace the batteries if necessary, following the instructions on 3.
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You get an error message when you try to transfer your pictures from the 

camera to your Macintosh. 

❙ Make sure the cable is connected correctly, as described on 1.

❙ Make sure the camera is turned on and the batteries have enough 

power. 

❙ Open the Chooser (or Network Control Panel) and make sure 

AppleTalk is inactive.

❙ Check the computer connection settings in your PhotoPC software. 

You may need to change the settings for the Port and Speed as 

described on page 4. 

❙ If you’re using a PowerBook Duo,™ open the PowerBook Setup 

Control Panel and make sure it’s set to Standard mode. Then restart 

your Macintosh.

Your pictures transfer too slowly from the camera to your Macintosh, 

and the transfer process uses up your batteries too quickly.

❙ Try increasing your port speed. Using your PhotoPC Settings 

software, you can choose the fastest speed that works on your 

Macintosh, up to 57,600 baud. See pages 5-4 to 5-5 for more 

information.

You are unable to copy and paste or import your photo into a document.

❙ Try increasing your virtual memory. For example, if you have 

8MB RAM, increase your virtual memory to 16MB. You can do 

this in the Memory Control Panel.

❙ Increase the memory allocation for your word processor or other 

software by following these steps:

1 Click the software icon to select it. 

2 Choose Get Info from the File menu to find the application’s  

memory  allocation settings.

3 Increase the memory to 4000K or 5000K. 

❙ Try turning off any extensions that are unecessary. Certain 

extensions might conflict with either of the software applications. 
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See your  Macintosh documentation or online help for more 

information on changing memory settings and turning off 

extensions.

Solving Picture Problems
If you’re not satisfied with the pictures you get from PhotoPC, you may 

need to adjust some of the camera settings. Or maybe you need to brush 

up on your photography techniques. Read the suggestions listed below 

and give them a try.

Your pictures display poor image quality on the screen or when you 

print them out.

❙ PhotoPC captures images in 24-bit color (millions of colors). Your 

pictures do not display maximum image quality if your monitor or 

your Macintosh’s video capability doesn’t support at least 

thousands of colors. You may need to upgrade your system to 

achieve the best possible image quality.

❙ If your pictures look better on the screen than when you print them 

out, you may need to upgrade your printer. An EPSON color ink jet 

printer, for example, provides excellent image quality.

Your picture is blurry or out of focus.

❙ Make sure your subject is within the camera’s range. You should 

be at least 2 feet away to take a picture without the flash, and 3 to 

10 feet away to take a picture with the flash.

❙ Make sure you hold the camera steady until you hear the beep.

❙ Make sure your subject isn’t moving. If you want to photograph a 

moving subject, try increasing the shutter speed. For information 

about changing the shutter speed, see 3.

❙ Make sure your flash setting is either automatic or forced flash, as 

described on page 5.
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Your picture is too dark (underexposed).

❙ You may need to use the flash. Make sure the flash setting is either 

automatic or forced flash, as described on page 5.

❙ If you’re using the flash, make sure your subject is within the range 

of 3 to 10 feet.

❙ Use EasyPhoto or another image editing program to adjust the 

picture’s brightness and contrast. See 

7 for instructions.

Your picture is too light (overexposed).

❙ If you’re using the forced flash setting, it may be too bright. Try 

setting the flash to auto 5.

❙ The camera’s light sensor may be covered or dirty. Make sure 

you’re not blocking it when you take pictures. You may need to 

clean it with a soft, dry cloth.

❙ If you’re facing a bright light source, you may need to shoot your 

picture from a different angle.

❙ If you’re taking pictures in the snow or at the beach on a sunny day, 

you may need to use an ND filter. A 37 mm ND-4 camcorder filter 

should work in most cases.

❙ Use EasyPhoto or another image editing program to adjust the 

picture’s brightness and contrast. See 

7 for instructions.

Part of your picture is missing.

❙ Make sure you’re not blocking the lens with your finger, hand 

strap, clothing, or other object.

A horizontal or vertical red line appears on your picture.

❙ Red lines are caused by glare. Avoid photographing very shiny 

surfaces that reflect a glare of light into your lens.

❙ In very bright light, you may need to use an ND filter to avoid 

glare. Try a 37 mm ND-4 camcorder filter.

The wrong date and/or time are displayed on your pictures.

❙ You need to connect the camera to your Macintosh and reset the 

camera’s clock. See 2 for instructions. Whenever you change the 

camera’s batteries you need to reset the clock.

The colors in your picture don’t look right.

❙ When you take pictures under certain artificial lighting conditions, 

the colors may be slightly distorted. You can use EasyPhoto to 

adjust the colors. See 7 for instructions.
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Your pictures don’t look as good as they used to.

❙ Your camera’s lens may be dirty or dusty. Try cleaning it as 

described on page 1.
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hotoPC’s flexibility allows you to use it

with a variety of options. You can increase the camera’s 

storage capacity by installing a 2MB or 4MB PhotoSpan™ memory 

module. To help you save battery power, particularly when 

transferring pictures to your Macintosh, you can use the optional AC 

adapter.

The PhotoSpan module and AC adapter should be    available where 

you bought your PhotoPC. You can also order them from EPSON 

Accessories at (800) 873-7766 (U.S. sales only). In Canada, call 

(800) GO-EPSON. 

For close-ups, wide-angle pictures, and special effects, you can use 

any standard 37 mm video camcorder lens or filter. See page A-5 for 

recommendations and ordering information.

A   Using Optional Accessories

P This chapter includes the following instructions:

❙ Expanding your PhotoPC Memory

❙ Installing the PhotoSpan memory modules

❙ Using the universal AC adapter

❙ Using optional lenses.

Expanding Your PhotoPC Memory 
PhotoPC comes with 1MB of internal memory, which holds up to 16 

pictures at high resolution or 32 pictures at standard resolution. You can 

increase the camera’s capacity by installing a 2MB or 4MB PhotoSpan 

external memory module (flash memory board), as described in the table 

on page A-2. 



A-2   Using Optional Accessories

: 

CAUTION

Once you install a PhotoSpan module, you can’t remove it. Make sure 

you think about your future needs before you decide whether to install 

the 2MB module or the 4MB module.

Installing PhotoSpan Memory Modules 
Before you install a PhotoSpan module, make sure you erase all pictures 

in the camera and turn it off. 

CAUTION

PhotoSpan modules are sensitive to static electricity and easily 

damaged. Be sure you ground yourself by touching a metal object before 

you handle the module, and never touch the module’s metallic area.

Follow these steps to install a PhotoSpan module: 

1 Open the battery compartment and remove the batteries as 

described on page 1-3.

2 Place the camera on end to access the memory socket cover tabs.

3 Press down on the tabs with your thumbs and carefully pull the 

socket cover away from the camera.

PhotoPC capacity

Number of photos
1MB internal 
memory

With 2MB 
PhotoSpan
A882401

With 4MB 
PhotoSpan
A882411

At high resolution 16 48 80

At standard resolution 32 96 160

memory socket 
cover tabs
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4 Position the module so that the notch is aligned with the rounded 

corner of the socket.

5 Slide the module into the socket at an angle as shown, pressing 

along the edge until it clicks into place.

6 Press down on the module until it snaps into the retaining clips at 

the sides of the socket.

7 Place the socket cover on the camera body and press down until it 

snaps into place.

8 Replace the batteries in the battery compartment and replace the 

battery cover as described on page 1-3.

When you take your next picture, the pictures remaining number on the 

control panel shows your camera’s expanded capacity.

With expanded memory, you may notice a delay between the time you 

press the shutter button and when the camera beeps. You can reduce this 

delay by pressing the button down halfway, holding it until you’re ready 

to take the picture, and then pressing it down the rest of the way. 

notch

 rounded corner

retaining clip
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Using the Universal AC Adapter 
The Universal AC adapter (A883021) allows you to connect your 

camera to a standard electrical outlet. This is especially useful when you 

are transferring pictures and operating the camera from your Macintosh. 

The adapter powers the camera, but does not charge the batteries. 

WARNING

❙       Use only the adapter designed for PhotoPC. Using any other 

        adapter may cause fire, electrical shock, or injury.

❙       Do not alter the plug on the power cable, and do not use the 

        adapter for any purpose other than powering your PhotoPC. 

❙       If the power cable plug doesn’t fit your outlet, use a power 

        cable. with a plug that fits.

To avoid losing any images or settings, make sure the camera is finished 

processing and turned off before you connect or disconnect the AC 

adapter. Then follow these steps:

1 Locate the port cover on the side of the camera. Press on the arrows 

and slide the cover down to open it.

2 Plug the adapter cable into the DC port on the camera.

EPSON AMERICA INC
TITLE

                       Cam3-01.eps

arrows

EPSON AMERICA, INC.
Documentation Department
20770 Madrona Avenue, Torrance, CA 90503
(310) 782-0770

TITLE

                       Cam3-02.eps
DATE

                       6/26/95
DRAWN BY

L Oliver

DC port
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3 Plug the end of the power cable into the adapter.

4 Connect the other end of the power cable to an electrical outlet. 

Using Optional Lenses
Although you can use any standard 37 mm video camcorder lens or filter 

with PhotoPC, lenses manufactured by Tiffen are recommended. Call 

DC Pro at (800) 522-7835 for ordering information.

To attach a lens, screw it onto the camera as shown below.

When you use a close-up lens, the viewfinder does not give you an 

accurate image of your picture. The best way to take close-up pictures is 

by connecting the camera to your Macintosh. You can use the live 

preview feature to see your images on the screen before you capture 

them. See

page 5-5 for more information about taking pictures from your 

Macintosh. 

CAUTION

Handle the camera carefully and avoid jarring it when using an optional 

lens.
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Physical Dimensions 

B   Specifications

Width 6.5 in. (166 mm)

Height 3.5 in. (88 mm)

Depth 1.9 in. (47 mm)

Weight
(without batteries)

11 oz. (310 g)

Power
Sources 4 AA batteries (single-use alkaline, single-

use lithium, or rechargeable Ni-Cad)

Optional universal AC adapter (A883021)

Consumption Approximately 100 milliwatt
at power-on

Approximately 4 W during image 
processing

Maximum 12 W during flash discharge
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Technical Photographic

Product type CCD (charge coupled device)
still frame camera

Image size 640 × 480 pixels 
(high resolution)

320 × 240 pixels 
(standard resolution)

Bit depth 16 million colors, 24-bit

Serial interface 8-pin DIN (camera); 
8-pin DIN (Macintosh)

(Cable adapter for RS-232C interface in 
PhotoPC Mac version)

Internal memory 1MB flash memory

Optional expansion 
memory

2MB (0.5MB flash memory × 4 chips)

4MB (0.5MB flash memory × 8 chips)

Lens f = 6 mm (equivalent to a 43 mm lens on a 
35 mm camera)

Range 2 ft (60 cm) to infinity

Exposure Equivalent to ISO 130

Shutter Automatic electronic shutter, 
1/30 to 1/10,000 second

Viewfinder Optical

Aperture f5.6

Flash modes Auto, forced flash, off

Flash range 3 ft to 10 ft (1 m to 3 m)
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     AC Adapter, universal, A-4
     Accessories (optional),  Intro-2, A-1–5
     Adding picture information,  4-2
     Adjusting

     brightness and contrast,  4-7
     colors,  4-8
     port settings,  5-4
     settings

     flash,  2-5
     resolution,  2-6
     timer,  2-8

     Advanced features
     adjusting port settings,  5-4
     getting ready to use, 5-1
     setting auto shut-off,  5-3
     setting clock,  5-2
     setting shutter speed,  5-3
     taking pictures from your computer,  5-5

     Attaching the hand strap,  1-5
     Auto flash setting,  2-5
     Auto shut-off,  2-2, 3-3, 5-6

Index

B
Batteries

handling,  1-4
installing,  1-3
power levels,  2-3

BBS Download Service (EPSON),  Intro-3
Brightness, adjusting,  4-7

C
Camera

maintenance,  6-1
problems,  6-2

Changing file information,  4-10
Changing picture information,  4-2
Changing pictures using Photo Workshop,  4-5
Checking battery icon,  2-3
Clipboard,  4-9
Clock, setting,  5-2
Close-up lens,  A-5
Closing EasyPhoto,  3-11
Colors, adjusting,  4-8
CompuServe (Epson America Forum),  Intro-4
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Connecting camera to computer,  3-1
Contrast, adjusting,  4-7
Control panel,  2-2
Copying image to clipboard,  4-9
Cropping pictures,  4-6
Customer support services,  Intro-3
Cutting part of picture,  4-9

D
Displaying gallery as slide show,  4-4
Documents, using pictures in,  3-6

E
EasyPhoto

closing,  3-11
installing,  1-5
making changes with Photo Workshop,  4-5
organizing pictures,  4-1
using advanced features,  5-1

EasyTouch control panel,  2-2
EPSON

customer support services,  Intro-3
Download Service (BBS),  Intro-4
Epson America Forum on CompuServe,  Intro-4
Internet FTP Site,  Intro-4
World Wide Web, Intro- 3

Erasing picture,  2-9, 3-6
Expanding memory,  A-1

F
Features,  Intro-2, 1-2
File information, changing,  4-10
Finding picture in a gallery,  4-3
Flash settings,  2-5
Flipping picture,  4-9
FTP Site,  Intro-4

G
Galleries

displaying as slide show,  4-4
using,  4-2

Getting help,  Intro-3

H
Hand strap, attaching,  1-5
Handling batteries,  1-4
Help, EPSON,  Intro-3
High resolution setting,  2-6

I
Inserting picture into document

importing,  3-10
using copy and paste,  3-7
using drag and drop,  3-9

Installing
batteries,  1-3
EasyPhoto software,  1-5
memory modules,  A-2

Internet FTP site,  Intro-4



Index   3

A

B

L
Lens, using,  A-5
Live preview,  5-6

M
Maintenance

cleaning,  6-1
storage,  6-2

O
Online support,  Intro-3
Optional lenses,  A-5
Organizing your pictures,  4-2

P
Pasting image from clipboard,  4-9
Photo Workshop,  4-5–9
PhotoPC

accessories,  Intro-2, A-1–5
advanced features,  5-1
capacity,  A-1
connecting camera to computer,  3-1
features,  Intro-2
how to take pictures,  2-1
maintenance,  6-1
options

AC adapter,  A-4
adding memory,  A-1
lens,  A-5

problems and solutions,  6-2

registration card,  Intro-5
removing the plastic film,  1-5
safety instructions,  Intro-5
specifications,  B-1–2
system requirements,  Intro-2

PhotoSpan memory module,  A-1–2
Picture counters,  2-9
Picture information,  4-2
Pictures

adding or changing information,  4-2
copying to clipboard,  4-9
cutting,  4-9
editing,  4-5–9
erasing,  2-9, 3-6
files,  4-10
finding

by resemblance,  4-4
by words,  4-3

flipping,  4-9
in galleries,  4-2–5
inserting in documents,  3-6–10
organizing,  4-2
pasting from clipboard,  4-9
printing,  4-9
problems,  6-3
rotating,  4-7
saving,  4-9
taking,  2-3–8

Plastic film, removing,  1-5
Plug-in, 1-6, 3-6
Port settings,  5-4
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Printing,  4-9
Problems,  6-2

R
Recording time and date,  5-2
Registering PhotoPC,  Intro-5
Removing red-eye,  4-8
Removing plastic film,  1-5
Resizing pictures,  4-6
Resolution settings (high and standard),  2-6
Rotating pictures,  4-7

S
Safety instructions,  Intro-5
Saving pictures,  4-9
Searching for pictures

by resemblance,  4-4
by words,  4-3

Setting
auto shut-off,  5-3
clock,  5-2
flash,  2-5
port and speed,  5-4
resolution,  2-6
shutter speed,  5-3
timer,  2-8

Show live preview,  5-6
Shutter speed,  5-3
Slide show feature,  4-4

Snapping shutter
from your computer,  5-7
on camera,  2-3

Specifications,  B-1–2
Standard resolution setting,  2-6
Support,  Intro-3–5

T
Taking pictures

from computer,  5-5
outdoors,  2-4
snapping shutter,  2-3
with timer,  2-8

Technical Support,  Intro-3–5
Timer settings,  2-8
Transferring pictures to computer,  3-4
Troubleshooting,  6-2
Turning camera on and off,  2-2

U
Universal AC adapter,  A-4

W
World Wide Web,  Intro-3

Z
Zoom feature,  4-5
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